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Installation
PC requirements :-

PC tower -
Pentium 2 — 4 (500MHz and Above)
128Mb Ram
Floppy Disk Drive , CD-ROM or If downloading from Internet ( Modem )
Hard Disk = 2GB At Least
Software :
Operating Systems Win 98 SE, Win2000, Windows ME, Windows
NT, Win XP
Software Applications : If C&E was downloaded from Internet .
User will need Win RAR Application to Unzip/unRAR downloaded Cause and
Effect file.

Installation Guide setup.
Click on Setup. If file is in Win RAR format. Run Win RAR , Then unzip/un compress file

to a folder then click setup

File Edit ‘Wiew Favorites Tools  Help
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\ ? ) This will install GLT Premier AL Design System Yersion 1. Do you wish ko continue?

Yes Mo |




Install and follow instructions. Accept License and choose program folder path.
|3

GLT Premier AL Design System Version 1

x|
Wielcame ta the GLT Premier A Design System Yersion

1 setup pragram. This will installlke T Premier AL Design
Spstemy1 14/11/2003 on yaur compuiter.

Itis strongly recommended that vou close all ather
applications pou have running before continuing. This
will help prevent any conflicts during the installation
piocess.

Click Next to continue, or Cancel to exit Setup

| cancd
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Once Installed, Run program either via shortcut or from programs Menu.

GLT Premier Cause,Effect System
Wew Job  EditJob  Setup  Quit

Version 1 14/11/2003

Click on ‘New Job* or press 'ALT' and ‘N* together in order to start defining
a new network system.

Click on 'Edit Job' or press 'ALT' and 'E' together in ord&r 1o work on an
existing network system.

Click on 'Quit’ or press "ALT" and 'Q’ together in order to exit from this
program and return to Windows.




3. CAUSE/EFFECT PROGRAMMING SYSTEM
CABLE CONNECTIONS FOR DOWNLOAD

1.PC to Premier AL / GLOBAL NET REP | Null Modem Cable

2.PC USB PORT to Premier AL or USB to Serial COMM D-TYPE Converter
PC USB PORT to Premier AL GLOBAL | Box/Unit+ 1 USB CABLE +1 NULL

NETWORK REPEATER MODEM CABLE

This document is a description of the cause/effect programming system for
the Premier AL network system. The equipment is currently limited to two
panel types, the Premier AL Global network repeater and the Premier AL 1-4
loop analogue addressable panel.

Each job designed on this system will have a 5 digit contract number that

is included in all of the file-names used for that job, and is also the

name of the directory where the files are stored, whether on a hard disk

or a floppy disk. There will also be a twenty character contract name to

be specified, together with a twenty character name for each panel on the
system.

Once a job has been fully designed, a wide variety of printouts can be
generated for reference, and a hex file will be generated for each

appropriate panel that can then be downloaded into that panel directly

from a computer, or may be programmed into an appropriate EPROM or EEPROM
first, and then the EPROM taken to the panel and installed.

First Create A JOB FILE .If no existing File/ Panel Cause And Effect file is present.
Select 1. New Job. Fill in Fields , i.e job name , file number and folder path etc

Please enter the JOB/CONTRACT number as b digits.
_
Path for Design File:

Please enter the directory path for the design files. Press 'ENTER*
to accept path shown.

‘c;\33333\

Job Name
‘ Please enter the overall JOBICONTRAC&name,

MANUAL DEMD |

distart| @ 3 O 5 @ = @ 3@speed...




If an existing File/ Panel Cause And Effect file is present. Then click 2.Edit job. Find the
file via folders . Double click on job number

U] GLT Premier AL Design - Existing Design Selection

Edit Guit

T1111HO0.XNT
22Z22H00.XNT

&E \
@EauwANDEﬂecl Conf]
NETWORK_PREM_A;

Select the network design file using the drive. directory and file
lists above. and then click on 'Edit* to proceed to the main edit
menu screen. otherwise click on 'Quit' to abandon the selection of
an existing design. n.b. to select just using the keyboard. use the

TAB key to move between each box. and for selecting the disk
drive press the letter for the drive {(a.b or c). and select from the
other lists using the arrow keys to move the highlight to the
required item. then press enter to confirm.

Wistart| @ B O 5 @ = @ .Epeed..‘l @Dc++...| ﬁkaspe..] ﬁsnftware| W] pcPR... | ZetaAu.l @a\}ru‘..l ﬂGLTPrH.l 2HO K@Y =z
If creating A new Panel. Click Panel Menu, and Add Panel. Choose Panel Type.
ption is Not relevant)******x**

Job Number

Identify New Panel

_

mm,l Tace clEjhbonciians MANUAL DEMO| Panel Number

002 HILTON Hij| Panel Type [OMone |

003 LEISURE 7.Computer System

004 GLT HERDI A [10]Premier AL Network Repeater
B.[11]Piemier AL 1-2/1-4 Loop Panel

005 SHAHSER

006 REP ALG JJ| The panel number shown may be incremented or deciemented as requned
using the scroll-bar next to it, but only fiee panel numbers are allowed.

The panel name may be edited using the keyboard. if necessary clicking on
it first with the mouse.

The panel type should by identified by selecting it from the list given. using
the scioll bars as necessary.

IClick on the "0K’ button to accept the data shown and add the panel to the
iob specification, or click on the 'Exit’ button to abandon this new panel.




Once the Panel Has been created, it now needs editing
Highlight Panel in Existing panel Window and Click Edit Panel Data Menu

ik GLT Premier AL Cause/Effect Editor
Panels Edit Panel Data b Hex Files CommPort  Quit

Job Number

TYPE"

B.[11]Premier AL 1-2/1-4 Loop Panel

B.[11]Premier AL 1-2/1-4 Loop Panel

B.[11]Premier AL 1-2/1-4 Loop Panel

B.[11]Premier A, 1-2/1-4 Loop Panel
(005 SWANSER THDUSTRIAL  B.[11]Premier AL 1-2/1-4 Loop Panel
006 REP ALG PREM AL GHR h.[10]Premier AL Hetwwork Repeater

ﬂl a8 G a9 .SDBEd...I @DC++‘..| @ Kaspe... | asuftwarsl W) PCFR... I ZetaA.‘.I ) al_pro... “ﬁGLTP... ‘sg@ﬂ‘ﬁ“

EDIT PANEL DATA MENU BRINGS UP A NEW WINDOW. WHICH IS WHERE THE
USER CAN CONFIGURE CAUSE AND EFFECT



The Grey Menu Bar , is where the User Defines/Sets Premier Al Function and Behaviour.

ESGLT Premier AL Cause/Effect - Premier AL Panel Main Editor

Wiew  Panel Layout Special Functions  Sensitivity  Select Output  Allocate Zonesf@roups  Edit Texts  Prink  Quit

Job Number
Panl Nunber [Dicctoy |

1.View Menu. Shows the Panels and the Available flags, i.e Cause types, e.g, Commom
fire.

Zones/Groups  Edit Texts: Brint  Quit

Job Number
Panel Number [ Diectory |

Available Flags for Panel 4 GLT HEADQUARTERS

002 HILTON HOTEL

003 LEISURE CEHTRE

{004 GLT HERADQUARTERS

005 SWAHSER IHDUSTRIAL 11
006 REP ALG PREM AL GHR 10

Mum. Function

0001 Common Fire Till Reset

0002 Common Alert Till Clear

0003 Common Fault Till Clear

0004 Common Indication Till Clear
0005 Common Loop Fault Till Clear
0006 Common Alarm Fault Till Clear

Select a panel to view itz network flags. Click on Exit to close this window.




2.Panal Layout Menu. User defines, Number of Loops, Repeaters(LOCAL), 1/0
Boards.etc
Use the arrow keys, to define the number of repeater s, i/o boards , loop cards.

LT Premier AL Cause/Effect - Premier AL Panel Main Editor

Wiew  PanelLayout  SpeciallFunckions  Sensitivity. Seleck Output Allocate Zones/Grodps  Edit Texts  Brint  Guit
Job Details

0 Job Number [ 11111 | Job Name | d |

| Panel Humber | L | |Panel Name| SWANSEA | | Directory |C:\Cause.ANDEﬂect |

Panel Layout 5pecification

Lo 1701 170 2 170 3 170 4 170 5 170 6 170 7
hd
170 8 170 9 170 10 170 11 170 12 170 13 170 14

REPEATERS

||

ﬂm 170 15 170 16 170 17 170 18 170 19 170 20 170 21
IJ'EI 22 IJ'III 23 I!l:l 24 IJ'III 25 IJ'III 28 IJ'III 2? IJ'III 28
IJ'EI 29 IJ'III 3l] I!l:l 31

Click on the up or down arrow on the appropriate panel box to increase or decreaze the number of loops or
repeaters. Click on an 170 box to change itz type to that highlighted in the list on the left. and click on
the list itzelf to select a different type. Click on "0K" when all of the information is comrect. n.b. 1/0 boards
must be allocated in from ber 1

170 Boards
one

3.11.Special Functions > Time Functions > Panel Delay. User defines Delay Duration and
Start / Stop Time.

GLT Premier AL Cause/Effect - Premier AL Panel Main Editor |
Wiew  Panel Layout  SpeciallFunckions  Sensitivity.  Select Output Allocate¥eones/Groups  Edit Texts  Brint  Guit
Job Details

0 Job Mumber [ 11111 | Job Name | d |

| Panel Humber | L | |Panel Name| SWANSEA | | Directory |C:\Cause.ANDEﬂect |

Panel Delay Parameters

Time Settings [24 Hour Clock] Duration Settings [Minutes]

Panel Delay Start Time Panel Delay Duration m

Panel Delay End Time

Click on any time parameter [white box] to edit itz value.
Click on the up or down arrow on the Duration box to increase or decrease the panel delay duration in
minutes.

Click on the 'OK' button when all of the parameters are comect.




3.12.Special Functions > Time Functions > DAY/NIGHT . User defines Day and Night
mode settings. After office Hours Fyreye Detectors will go to Night time sensitivity
settings.

GLT Premier AL Cause/Effect - Premier AL Panel Main Editor x|

Yiew Panellayout  Special Funchions: Semsitivity.  Select Gutput Allocatesones/Groups. Edit Texts  Print Quit
Job Details

0 Job Number | 11111 [ Job Name ] d |

| FPanel Number | 5 | |Pane| Namel SWANSEA | | Directory |C:\Cause.ANDEﬂecl |

Day/Might Mode Parameters
Time Settings [24 Hour Clock])

Day OF Week

uesday

ednesday

—N=f =
~fl o~

hursday

riday

-
-l

— —
~ ~

-
-~

Click on any time parameter [white box] to edit its value.
ck on the '0K’ button when all of the parameters are comect.

3.13Special Functions > Time Functions > Software Timers. User can set software timer
events. Only 1 Group can a software timer be allocated. (not to a zone)

GLT Premier AL Cause/Effect - Premier AL Panel Main Editor |

Panel Layout  Special Functions  Sensitivity.  Select Output  Allocatelsnes/Groups  Edit Texts  Print  Guit
Job Details

0 Job Number | 11111 | Job Name | d |

[ Panel Number [ 5 | [Panel Name] SWANSEA | [ Directory | C:\CauseANDEffect |

Software Timer Periods
’—Timm 1 [(Input/Output 249]

’—Timel 1 [Input/Dutput 249)

’—Timm 1 [(Input/Output 249]

’—Timm 1 [(Input/Output 249]

Click on the appropriate button above to edit the delay period for a
software timer, select either Fire or Indication as required, then click on
'Save' to save the changes. or click on 'Cancel' to exit without saving.

C. |
Select Fire for driving sounders at the end of the delay. or to latch any
outputs at the end of the delay.




3.21Special Functions > Time Functions > Access code. Type Old code to enter new code
LT Premier AL Cause/Effect - Premier AL Panel Main Editor |
Wiy Panel Layout  Special Functions  Sensitivity)  Select Gutput  Allacans Zones/Groups  Edit Texts  Print Qi

Job Detail
©° (' T Numbor [11771] [555 Nome | modsgassar— ]|
Pancl Number Panel Nome

Panel Access Code

Current Access Code
Enter a New Access Code Here

The access code as saved on disk may be

edited in the white box above. but must consist

of four decimal digits. Click on the "Save’

button to save the new code if it is valid before

exiting thiz function. Click on 'Cancel’ to exit LCancel
thiz function without saving.

3.31Special Functions > Time Functions > Network Responses. User text is recommended.
User defines if or how a panel responds to network flags, causes, events etc
. GLT Premier AL Panel Network Responses -1al x|

Job Number Job Details
Pancl Number

001 FACP CLEAN SLATE 11

| r— | r— | r—
| r— | r— | r—
| | r— | — r—
|| r— | rr—

Select a panel from the drop-down list above to view/edit the responzes of the

current panel to ges from that ted panel. then click on a rezponsze
option to zet that response option for the selected panels. Click on Save to
save the changes and exit. Click on Exit to exit without saving the changes.




3.32 Special Functions > Time Functions > Platform sounders. User declares platform
sounder that need configuring .Hence are then controllable by the user , and can be
programmed as a Loop output.(Effect) **USE FOR ZETA SOUNDER BASE FEA SB**

m GLT Premier AL Panel Platlorm Sounder Id entikil:atiun =101 %]

Loop  Select  Save Details Done

Job Details

1 Job Number [11111 [ Job Hame | madagascar |

| Panel Humber | Ll | |Panel Name| SWANSEA | | Directory |E:\Eause.ANDEl[ect |

Platform 5ounder Usage

Use Platform Sounder
Mo Platform Sounder

Number of Addresses Selected
R FOINT TEXT TYFE BOUNDER

x

Are you sure that you want to add a platform sounder to address
37

The 'Loop' menu item allows the required loop
The "Select’ menu item allows all addresses to
addrezzes may be zelected or de-selected by
uzing the Shift key to select ranges.
The'Save' menu item allows data to be saved
The'Done' menu iterm returns ba the main pane
Clicking on a parameter buttan while some ad:
update the appropriate pararmeter for the selec
suzpect combinations.

Ies Yes To All Ho LCancel

4.11 Sensitivity > Default : Settings > Categories The sensitivity option menu.
Choose default to declare type of detector (Cause), that are connected . Sensors to be
declared as FYREYE ANALOGUE. ******DO NOT DECALRE ZIOU (ZETA
INPUT/OUTPUT UNIT AS A FYREYE 1/O UN|T)****xxk

. GLT Premier AL Panel Delaulk Sensitivity Levels =181 x]

Loop  Select  Settings  Save Details  Done k

Job Details

10 Job Number [ 11111 [ Job Hame | madagascar |
[ Panel Humber [ 5 | [Panel Name] SWANSEA | [ Directory [C:\CauseANDEffect |

Number of Addiesses Selected Mon-Configurable

Fyreye Analogue

Fyreye 170 Unit

r Instructions
The 'Loop' menu item allows the required loop to be selected.
The 'Select’ menu item allows all addresses to be selected or de-selected, Individual
addreszzes may be selected or de-selected by directly clicking on them in the list.

The 'Settings” menu item allows either the ‘Categary’, ‘alert Trip', 'Fire Trip’, or i#o unit
mode to be edited.

The'Save' menu item allows data to be saved either for all loops or just the current
loop.

The'Done' menu item retums ta the main patel editing window.

Clicking on a parameter button while some addrezzes in the list are selected will ty to
update the appropriate parameter for the selected addresses, with suitable prompts for
any suzpect combinations.




4.12 Sensitivity > Default : Settings > Alert trips User can set alert trips(pre-alarm
condition), via the settings menu.
i, GLT Premier AL Panel Default Sensitivity Ln*ﬂ’els
Loop  Select  Settings  Sawve Details Done

Job Detailz
10

=10l x]

| Job Humber | 11111 | | Job Hame | madagascar |
[ Panel Number [ 5 | [Panel Name] SWANSEA | [ Directory [C:ACauseANDEFfect |

Number of Addresses Selected

These zettings reprezent the
analogue value at which an
Alert [or Pre-alarm] condition will
be recognized from a Fyreye
analogue zenzor

r Instructions
The 'Loop' menu item allows the required loop to be selected.
The 'Select’ menu item alloves all addreszes to be selected or de-selected. Individual
addreszes may be selected or de-zelected by directly clicking on them in the list.

The 'Settings' menu item allows either the "Category’, 'Alert Trip', 'Fire Trip', or i/a unit
mode to be edited.

The'Save' menu item allows data to be saved either for all loops o just the curent
loop.

The'Done' menu item returns to the main panel editing window.

Clicking on a parameter button while some addresses in the list are selected will try to
update the appropriate parameter for the selected addreszses, with suitable prompts for
arny suzpect combinations.

4.13. Sensitivity > Default : Settings > Fire trips. User can program fire trips settings for
each individual sensor(cause)
&, GLT Premier AL Panel Default Sensilgyi =1Ol=l

Loop  Select  Setbings  Save Details Done

Job Details

10 Job Number [ 11111 [ Job Name ] madagascar |

[ Panel Humber [ 5 | [Panel Hame] SWANSEA | [ Ditectory [C:ACauseANDEffect |

Fire Trip Levels

These settings represent the
analogue value at which a Fire
condition would be recognized
from a Fyreye analogue sensor.
The normal value is 55.

r Instructions
The 'Loop' menu item allows the required loop to be selected.
The "Select’ menu item allows all addreszes to be selected or de-selected. Individual
addresses may be selected or de-zelected by directly clicking on them in the list.

The "Settings’ menu item allows either the 'Categony’, *Alert Trip', Fire Trip', or ido unit
mode to be edited.

The'Save' menu item allows data to be saved either for all loopz or just the current
loop.

The'Done' menu item returng to the main panel editing window.

Clicking an a parameter button while some addresses in the list are selected will ty to
update the appropriate parameter for the selected addresses, with suitable prampts For
any suspect combinations.




5.11 Sensitivity > Day Night: Settings > Categories User can set fire trip values , to each
individual sensor , for DAY TIME or NIGHT TIME settings.

. GLT Premier AL Panel Day/Night Sensitivity Levels =10] x|

Loop Select | Settings Save Details  Done |

Job Details: YE Fire Trips
0 MightTifme FYREYE Fire Trips

[ Job Name | madagascar |

Name| SWANSEA || Directory |E:\EauseANDEﬂecl |

DayTime Fire Trips

Number of Addresses Selected
DRY NIGHT

70
Thesze settings represent the
analogue value at which a Fire
condition would be recognized
_ from a FYREYE analogue

r Instructions sensor. The normal value is 55.
The 'Loop' menu itemn allows the required loop to be selected. These are the values uzed in
The 'Select’ menu item allows all addrezzes to be selected or de-zelected. Individual the da_}llime_when day/night
addresses may be selected or de-selected by directly Contral-clicking on them in the list, o |RUEEEREIETATES

uzing the Shift key to select rahges.

The 'Settings’ menu item allows either the D aytime or Mighttime Fire Trip to be edited.

The'Save' menu item allows data to be saved either for all loops or just the current loop.
The'Dlone' menu item returns to the main panel editing window.

Clicking on a parameter button while some addreszes in the list are selected will by to
update the appropriate parameter for the selected addreszes, with suitable prompts for any
suspect combinations.

6.11 Select Output > Loop outputs. The user MUST DECLARE outputs(effect). If a
Sounder is not declared , then it will not operate, even if the loop has configured it , on the
Premeir AL Loop Output C&E in the the engineers menu. All loop output devices must
be set, with Channel A(bit 0), B(bit 1), C (bit 2) Command settings.

=MGLT Premier AL Cause/Effect - Premier AL FankI Main Editor
Wiew  PanelLayout  Special Functions  Sensitivity  Select Cutput  Allocate ZonesjiGroups  Edit Texks  Print  Cuuit

Job Detail
98 DAl ok Number [ 11111 [JobName [ madagascar |

| Panel Humber | 5 | |Panel Name‘ SWANSEA | | Directory |D:\DauseANDEl[ecl |

Specify New Loop Dutput

1

Click on the required loop number. point addless and channel lo specﬂ_v a new

loop output. Click on '0OK" when the approp values are | d to

to enter a uzer text for the new output. or click on "Exit’ to abandon specifying a
new loop output.

Loop Dutput Text

Enter uzer text for loop output L1:0034
Cancel |

SOUNDER]




Once a loop out put is declared. Then the User can manipulate/program its
behaviour(effect). Highlight the loop output and CLICK the CAUSES Button.

x|
Yiews Panelllayout  Special Funchions  Sensitivity:  Select\Sutput allocate Zones/Groups  Edit Texts: Print  Guit
Job Details

0 Job Number | 11111 | Job Name | d |

| Panel Humber | L | ‘Panel Name| SWAMNSEA | | Directory |C:\Cause.ANDEﬂecl |

Loon Duiput CausedEifech
Loop Outpu(s) JL1:009A JSOUNDER ]

Causes

Cause Types

Select either ‘Local’ or "Metwork’ cause by clicking on the
ppropri button. Selecting "Metwork® will bring up a list of panels
zo0 that the source panel can be specified. while selecting "Local'

will give a list of available causes suitable for a stand-alone panel.

Clicking on ‘Exit" will return to the output cause list screen.

Add Cause Delete Cause(s) | Copy Cause(s] | Faste Cause(s] m

Choose either Local for a Single Panel. Or Network for a network of Panels.

***WARNING.MAKE SURE YOU ARE FULLY CAPABLE AND UNDERSTAND
CAUSE AND EFFECT. RECORD STATE OF CAUSES > AND RECORD NEW
CAUSES CREATED, SO THAT IT CAN BE DELETED IF PANEL DOES NOT
OPERATE OR GIVES A FAULT) USER MUST RETRACE STEPS, IN CASE USER
HAS TO DELETE A BADLY CREATED CAUSE AND EFFECT***

CHOOSING LOCAL WILL BRING UP ARANGE OF FLAG?CAUSE TYPES WHICH
ARE DEFINED :-

e Zone Fire Single Knock Operate Until Reset
One single device in fire within the assigned zone will cause the selected output to
operate until SYSTEM RESET.

e Zone Fire Single Knock Operate Until Silence
e Asabove except operates until SILENCE ALARMS is pressed.

Zone Fire Double Knock Operate Until Reset
e Two devices in fire within the assigned zone will cause the selected output to operate
until SYSTEM RESET.

e Zone Fire Double Knock Operate Until Silence
As above except operates until SILENCE ALARMS is pressed.

e Zone Fire Triple Knock Operate Until Reset



Three devices in fire within the assigned zone will cause the selected output to operate
until SYSTEM RESET.

Zone Fire Triple Knock Operate Until Silence
As above except operates until SILENCE ALARMS is pressed.

Zone Alert Operate Until Causes Clear
Any single device in alert within the assigned zone will cause the selected output to
operate until no longer in alert.

Zone Fault Operate Until Causes Clear
Any single device in fault within the assigned zone will cause the selected output to
operate until no longer in fault.

Zone Indication Operate Until Causes Clear
Any single indication only device (not fire, alert or fault mode) operated within the
assigned zone will cause the selected output to operate until the signal is removed.

Common Fire Operate Until Reset
Any device in fire will cause the selected output to operate until SYSTEM RESET.

Common Fire Operate Until Silence
As above except until SILENCE ALARMS is pressed.

Common Alert Operate Until Causes Clear
Any device in alert will cause the selected output to operate until no longer in alert.

Common Fault Operate Until Causes Clear
Any device in fault will cause the selected output to operate until no longer in fault.

Common Indication Operate Until Causes Clear
Any indication only device (not fire, alert or fault mode) operated will cause the
selected output to operate until the signal is removed.

Alarms Silenced Operate Until Causes Clear
Pressing the Alarms Silenced (or remote Alarms Silenced) control will cause the
selected output to operate until the signal is removed.

System Reset Operate Until Causes Clear
Pressing the System Reset (or remote System Reset) control will cause the selected
output to operate for 10-15 seconds until the signal is removed.

Evacuate Operate Until Causes Clear
Pressing the Evacuate (or remote Evacuate) control will cause the selected output to
operate until the system is no longer in Evacuate.

Zone Fire Single Knock Inhibit Until Reset



Any single device in fire within the assigned zone will prevent operation of the selected
output until SYSTEM RESET. If the selected output is already operating, this cause
condition will revert to its quiescent state.

Zone Fire Double Knock Inhibit Until Reset

Any two devices in fire within the assigned zone will prevent operation of the selected
output until SYSTEM RESET. If the selected output is already operating, it will revert
to its quiescent state.

Zone Alert Inhibit Until Causes Clear

Any single device in alert within the assigned zone will prevent operation of the
selected output until no longer in alert. If the selected output is already operating, it will
revert to its quiescent state.

Zone Fault Inhibit Until Causes Clear

Any single device in fault within the assigned zone will prevent operation of the
selected output until no longer in fault. If the selected output is already operating it will
revert to its quiescent state.

Zone Indication Inhibit Until Causes Clear

Any single indication only device (not fire, alert or fault mode) operated within the
assigned zone will prevent operation of the selected output until the signal is removed.
If the selected output is already operating, it will revert the selected output to its
quiescent state.

Common Fire Inhibit Until Reset

Any device in fire will prevent operation of the selected output until SYSTEM
RESET. If the selected output is already operating, it will revert the selected
output to its quiescent state. Common Alert Inhibit Until Causes Clear

Any device in alert will prevent operation of the selected output until no longer in alert.
If the selected output is already operating, it will revert the selected output to its
quiescent state.

Common Fault Inhibit Until Causes Clear

Any device in fault will prevent operation of the selected output until no longer in fault.
If the selected output is already operating, it will revert the selected output to its
quiescent state.

Common Indication Inhibit Until Causes Clear

Any indication only device (not fire, alert or fault mode) will prevent operation of the
selected output until the signal is removed. If the selected output is already operating, it
will revert the selected output to its quiescent state.

Alarms Silenced Inhibit Until Causes Clear

Pressing the Alarms Silenced (or remote Alarms Silenced) control will prevent
operation of the selected output until the signal is removed. If the selected output is
already operating, it will revert the selected output to its quiescent state.

System Reset Inhibit Until Causes Clear



e Pressing the System Reset (or remote System Reset) control will prevent operation of
the selected output for 10-15 seconds until the signal is removed. If the selected output
is already operating, it will revert the selected output to its quiescent state.

Evacuate Inhibit Until Causes Clear

e Pressing the Evacuate (or remote Evacuate) control will prevent operation of the
selected output until the system is no longer in Evacuate. If the selected output is
already operating, it will revert the selected output to its quiescent state.

CHOOSING NETWORK, WILL BRING A LIST OF PANELS AND CAUSES (FLAGS)
The flag or Cause definitions are the same, as above, with additional Flag/ Causes
available. These are:-

3.4.1. Add New Flag.Creating Unique Causes: WARNING.MAKE SURE YOU
ARE FULLY CAPABLE AND UNDERSTAND CAUSE AND EFFECT.
RECORD STATE OF CAUSES > AND RECORD NEW CAUSES CREATED,
SO THAT IT CAN BE DELETED IF PANEL DOES NOT OPERATE OR
GIVES A FAULT or ABADLY WRITTEN CAUSE AND EFFECT/MISTAKE)
**** TIP: BACK UP FOLDER THEN CREATE CAUSE AND EFFECT***
When this option is selected, a box appears identifying the new flag

number, and offering various option buttons plus a ‘Cancel’ button. Flag
specification takes place in four stages, with appropriate options being

given at each stage.

Wigwe  PanelLayout  Special Functions  Sensitivity  Select Output  Allocate Zones/Groups  Edit Texts  Print Quit
Job Details

0 Job Number | 11111 | Job Name | madagascar
|_ — GLT Premier AL Panel Flag Editing Program K

NSRS odd 5 Flag Delete Flag  Print  Quic
Loop O —Job Details

[Job Humber [11111 ] [ Job Name ] d. | [ Directory [ C:\CauseANDEFfect |
| [Panel Name|LEISURE CENTRE |

| Panel HNumber |

Mew Flag Cause Combination

HE05210H =L[}§Select required cause combination by clicking on the appropriate button, or
NGO52ZEVC=C] click on "Exit’ to abandon new Flag definition.
NG05230N =C
NGO05240M =L

[Flag Number [ 55
n.b. Flags 1-520 are pre-defined.

Single Knock | Double Knock Triple Knock

Single Knock Hange Double Knock Range Tople Knock Range

x
Enter a refersnce test for network flag 525
Cancel |

Select a

3.4.1.1. Stage 1 - Cause number & Combination Options.

There are six options on offer here, as well as a 'Cancel button to
return to the menu bar options.

3.4.1.1.1. Single Knock

Select this button to specify an individual cause to operate the flag by



itself. This allows for four types of cause:- Common Cause, Loop Cause,
Input Cause, or Zone Cause.

3.4.1.1.2. Double Knock

Select this button to specify two individual causes to operate the flag
when both causes are active simultaneously. This allows for three types of
cause:- Loop Cause, Input Cause, or Zone Cause.

3.4.1.1.3. Triple Knock

Select this button to specify three individual causes to operate the flag
when all three causes are active simultaneously. This allows for three
types of cause:- Loop Cause, Input Cause, or Zone Cause.

3.4.1.1.4. Single Knock Range

Select this button to specify a range of causes any one of which will
operate the flag by itself. This allows for three types of cause:- Loop
Cause, Input Cause, or Zone Cause.

3.4.1.1.5. Double Knock Range

Select this button to specify a range of causes to operate the flag when
when any two causes are active simultaneously. This allows for three types
of cause:- Loop Cause, Input Cause, or Zone Cause.

3.4.1.1.6. Triple Knock Range

Select this button to specify a range causes to operate the flag when any
three causes are active simultaneously. This allows for three types of
cause:- Loop Cause, Input Cause, or Zone Cause.

3.4.1.2. Stage 2 - Cause Type.

There are four possible options here:-

3.4.1.2.1. Common Cause

This option is only available as a Single Knock cause, and brings up a

list of available Common Causes together with an *OK" button and a
‘Cancel’ button.

3.4.1.2.2. Loop Cause

This option brings up a box with a list of available loop numbers, a list

of possible sensors, and a list of possible sensor status conditions,
together with an 'OK" button and a 'Cancel’ button.

3.4.1.2.3. Input Cause

This option brings up a box with a list of available inputs together with
an 'OK" button and a *Cancel" button.

3.4.1.2.4. Zone Cause

This option brings up a box with a list of possible zone numbers and a
list of possible zone status conditions, together with an 'OK" button and

a 'Cancel’ button.

3.4.1.3. Stage 3 - Cause Selection.

There are seven variations here:-

3.4.1.3.1. Single Common Cause

This involves clicking on a Common Cause in the list to select it, then
clicking on the *OK’ button to proceed to stage 4.

n.b. the Common Cause list will be removed from the screen as soon as the
cause is selected, or the "Cancel’ button is operated.

3.4.1.3.2. Single Loop Cause

This involves clicking on a loop humber, and a sensor number, and a
sensor status condition before operating the 'OK" button. An appropriate
number of loop causes need to be selected depending upon whether Single-
Knock, Double-Knock or Triple-Knock has been specified before proceeding



to stage 4.

n.b. the loop cause list will remain visible until sufficient causes have

been selected, or the ‘Cancel’ button is operated.

3.4.1.3.3. Single Input Cause

This involves clicking on an input number then operating the '‘OK' button.

An appropriate number of input causes need to be selected depending upon

whether Single-Knock, Double-Knock or Triple-Knock has been specified

before proceeding to stage 4.

n.b. the input cause list will remain visible until sufficient causes

have been selected, or the *Cancel’ button is operated.

3.4.1.3.4. Single Zone Cause

This involves clicking on a zone number and a zone status condition

before operating the *OK" button. An appropriate number of zone causes

need to be selected depending upon whether Single-Knock, Double-Knock or
Triple-Knock has been specified before proceeding to stage 4.

n.b. the zone cause list will remain visible until sufficient causes have

been selected, or the *Cancel’ button is operated.

3.4.1.3.5. Range of Loop Causes

This involves clicking on a loop number, and a range of sensor numbers,

and a sensor status condition before operating the "OK" button. The range

of sensor numbers is selected by moving the mouse pointer to the first

sensor number, pressing the left mouse button and dragging the mouse

pointer to the last sensor number before releasing the button. The

selected devices will be highlighted.

n.b. the loop cause list will be removed from the screen when either a

valid cause is selected, or the 'Cancel’ button is operated.

3.4.1.3.6. Range of Input Causes

This involves selecting a range of input numbers before operating the

'OK" button. The range of input numbers is selected by moving the mouse

pointer to the first input number, pressing the left mouse button and

dragging the mouse pointer to the last input number before releasing the

button. The selected inputs will be highlighted.

n.b. the input cause list will be removed from the screen when either a

valid cause is selected, or the *Cancel button is operated.

3.4.1.3.7. Range of Zone Causes

This involves selecting a range of zone numbers, and a zone status condition before
operating the 'OK' button. The range of zone numbers is selected by moving the
mouse pointer to the first zone number, pressing the left mouse button and dragging
the mouse pointer to the last zone number before releasing the button. The selected
zones will be highlighted.

n.b. the zone cause list will be removed from the screen when either a valid cause is
selected, or the 'Cancel’ button is operated.

3.4.1.4. Stage 4 - Clearing Mode Selection.

The options presented here will depend upon the cause type selected, but as soon as
one of these options has been selected then the appropriate cause will be added to the
definition for the current flag, and the program will return to stage 1 above, still for
the same flag, so that further causes may be specified for that flag.

3.4.1.4.1. On Till Cause Clear

This option is available for all cause types, and means that the flag will only be
activated while the cause itself is active.

3.4.1.4.2. On Till Silence



This option is available for 'Fire' causes only, and means that the flag will only be
activated until the alarms are silenced.

3.4.1.4.3. On Till Reset

This option is available for 'Fire' causes only, and means that the flag will remain
active until the system is reset. This normally has the same effect as ‘On Till Cause
Clear' because a 'Fire' cause is usually latching until reset.

3.4.1.4.4. Off Till Cause Clear :This option is available for all cause types, and means
that the flag will be forced off (inhibited) while the cause is active.

WHEN THE CAUSE IS CRETAED , THE USER MUST SAVE CAUSE, AT THIS
POINT OR CAUSE WILL NOT BE PROGRAMMED. THIS CAUSE IS PLACED INTO
THE HEX FILE FOR DONLOADING TO PANEL. THE HEX FILE RECORDS THE
PANEL CAUSE AND EFFECTS.

LOOP OUPUTS CAN BE DELETED , BUT THE CAUSES IN THEM , MUST BE
DELETED FIRST.

6.12 Select Output > Panel outputs. Software Timers and 1/O board Programming.
Cause and Effect are the Same as described for Loop Outputs.

WARNING.MAKE SURE YOU ARE FULLY CAPABLE AND UNDERSTAND CAUSE
AND EFFECT. RECORD STATE OF CAUSES > AND RECORD NEW CAUSES
CREATED, SO THAT IT CAN BE DELETED IF PANEL DOES NOT OPERATE OR
GIVES A FAULT)

Wiew  Pamellayout  Special Funckions  Sensibivity Selectout Allacate ZonesiGroups  Edit Texts  Print  Quit

Job Detail
" ™" Tich Numer [17711 [55b Nome [ modbgesear—]
[Panel Number |5 ] [Panel Name]  SWANSEA ]

[ALARM) Click on the list to
select an existing panel
output, or click on
‘Exit" to abandon panel
output zelection.




7.11 Allocate Zone/Groups > Allocate > Allocate Zone/Groups to Points.

This Section is where the USER , plans a list of which zones and groups the
sensor/detectors are to be allocated or placed in. Also Grouping in common or local .
There are 32 Zones, which are mutually exclusive. If sensor 1 is in zone 1, it cannot be
placed in any other Zone upto zone 32. It can however be placed in any zone/group from
33 to 248.

s, GLT Premier AL Panel Zone /Group Allocation x|

Wiew  Allocate Done
rJob Detailz
0

[Job Humber [ 11111 | [ Job Hame | madagascar |
[ Panel Humber [ 5 | [Panel Hame] SWANSEA | [ Directory [C:\CauseAMDEffect |

Select up to 1 zone [1-32] and/or up to ¥ groups [33-255). 1 loop and any combination of points,
then Click on "ADD" to add the selected zone/groups to the selected points,
or click on '"REMOVYE" to remove the selected zone/groups from the zelected points.
Usze the Shift key to select ranges. or the Control key for multiple individual addresses.
Click on ‘Done’ when finished.

Zones/Groups

]
]
]

Premier AL Zone/Group Allocation

n.b. Although the word ZONE is generally used in this area, zones 33-255
are reserved for cause/effect operations and are often referred to as

groups (including the panel menu pages). Each loop device may be allocated
to 1 zone (1-32) and up to 7 groups (33-255). Each panel input may be
allocated to up to 8 groups (33-255).

Here is Also where to REMOVE sensors from zones and Groups.
7.12 Allocate Zone/Groups > View >

This screen offers the following menu options:-

Allocate Zone/Groups > View > Zones groups for points

This brings up two boxes, one giving a list of available loops and a list

of sensor addresses, while the other gives up to the zone number and up to
seven group numbers and a 'Cancel" button. Whenever a loop number and a
sensor number are selected, the list of zones/groups identifies the

currently allocated zones/groups for that sensor.

Operating the 'Cancel" button clears these boxes from the screen and reenables
the menu options.

Allocate Zone/Groups > View > Zones groups for Input



This brings up two boxes, one giving a list of available panel inputs,
while the other gives up to eight group numbers and a "*Cancel’ button.

Allocate Zone/Groups > View > Point/inputs for zone group.
User can view what is allocated. (L1:001 = Loop 1, device address 001 is in zone 1)

i GLT Premier AL Panel Zone/Group Allocation X
Yiew Allocate  Done k

Job Humber
Panel Nunber [Directory ]

Click on a zone/group number to view itz inputs and points.
Click here or ‘Exit' button to remove the zone/group and allocation lists from the screen.

8.11 Edit texts > Select Text Category >

& GLT Premier AL Text Editor x|
Wiew Function Key Texts | Select Text Category  Quit

Panelijzme [ Directory |

Inputs
Panel Nun Qutputs E
Loop Qutputs
Paints
Zones/Groups
Mebwork Flags

Here the user can define Point texts, panel name etc.



**remember to press ENTER and also SAVE TEXT LABELS**

REMEMBER TO PRESS ENTER TO SAVE TEXT ON THE LINE. ALSO TO SAVE
AFTER EDITING TEXT LABELS. THE DEVICES / SENSORS / POINTS ARE NOW
LABELLED AND WILL SHOW UP ON THE DISPLAY OF THE PANEL, and AMS
ALARM MANAGER SOFTWARE.

9.11 Print . User Has certain parameters and Cause Effect settings that can be printed.
MAKE SURE A PRINTER IS ATTACHED TO PC.

I"'FIELT Premier AL Cause/Effect - Premier AL Panel Main Editor

Panel Layout  Special Functions  Sensitivity  Select Output  Allocate Zones/Groups  Edit Texks P Quit

Job Number Input Texts

Qukpuk Texks

[ Directory | Laop Output List
Poaint Texts
Dutput Cause/Effect
Loop Output CauseEffect
Panel Layout
Zone/Group Allocation
Timing Parameters
Sensitivity Codes
Metwork Responses
Flatform Sounders




‘g GLT Premier AL Cause,/Effect Editor ll

Panels  Edit Panel Data | Print  Hex Files  CommPort  Quit

[ et [ttt e

Pane Layout

Inputs
CaussfEffect tharts b Outputs

Zone Allocation Loop Outputs
002 HILTON HOTEL op Panel

Sensitivity Codes SEnsSOrs
003 LETSURE CEHTR
004 GLT HEADQUART anal val
005 STAHSER THDUS

W0t BED e pms  MetworkResponses
Platform Sounders

HUM. HAME
001 FACP CLEAH SL

Timing Parameters AL 1-241-4 Loop Panel

I
r AL 1-2/1-4 Loop Panel
i AL Network Repeater

start| B @ ©) 9 @ = 5 spesd. | # oo | @ aspe... | L menushs [[gFmiTen E]zeten. | G tnbor.. | B adobe... | [B 2D DIIE@E

***THE FACP PANEL EVENT HISTORY LOG IS NOT A PRINTABLE FEATURE. IT
IS NOT SUPPORTED.THIS IS BECAUSE IT CANNOT BE UPLOADED.***

10. DOWNLOADING TO PANEL:

WHEN YOU ARE READY TO COMMIT CAUSE AND EFFECT CONFIGURATION
AND SETTINGS TO PANEL. THEN YOU MUST DOWNLOAD CAUSE AND EFFECT
FILES TO PANEL VIA SERIAL COMM CONNECTOR CABLE OR USB TO SERIAL
COMM CONNECTOR CONVERTER CABLE.

GO INTO THE EDITOR WINDOW BELOW. HIGHLIGHT PANEL FILE.

CHECK CHANGES AND CHOOSE PANEL NUMBER WITH PANEL
HIGHLIGHTED

**WARNING: DO NOT CHOOSE ANOTHER PANEL NUMBER IF IT DOES NOT
MATCH THE HIGHLIGHTED PANEL. DO NOT CHECK CHANGES WITH PANEL
4, WITH PANEL 5 SETTINGS.**




% GLT Premier AL Cause/Effect Editor

Panels Edit Panel Data  Print | Hex Files CommPort  Quit

Foh Details [ Job Number
Dovindoad to Pansl

Make Hesx File

%]

}ling Panels

HUM . HAME TYPE"

001 FACP CLERH SLATE B.[11]Premier AL 1-2/1-4 Loop Panel
002 HILTON HOTEL B.[11]Premier AL 1-2/1-4 Loop Panel
003 LEISURE CEHTRE B. [11]Premier AL 1-2/1-4 Loop Panel

004 GLT HERADQUARTERS B.[11]Premier AL 1-271-4 Loop Panel

005 SWANSER IHDUSTRIAL B.[11]Premier AL 1-271-4 Loop Panel
006 REP ALG PREM AL GHR A.[10]Premier AL Hetwork Repeater

EI g @ 0 (o | Q i) @ .Speed..‘l @DC++...I @Kaspe... | |33 manuals ”t‘:?ET @Zeta.ﬁ..‘l @Inbox...l @Adobe.‘.l ’m
ONCE FINISHED CHOOSE MAKE HEX FILE.

Hex Files

This menu option includes sub-options for either creating hex files for any panels whose
cause/effect has changed, creating a hex file for the selected panel, or downloading
appropriate data to the selected panel.

If '"Check Changes' is selected then a list of panels whose cause/effect data has been
changed since their hex file was last created will be displayed, with the options to re-create
hex files for all of the listed panels, or to select individual panels to re-create hex files for.
In either case the appropriate hex-file program for each panel will be

executed in turn.

If 'Download’ is selected then the appropriate download program for the selected panel
type will be executed.

If "Make Hex File" is selected then the appropriate hex-file program for the selected panel
will be executed.

n.b. The 'Download’ programs that are currently available will be accessible directly from
Windows as separate Program Manager items, with a built-in facility to locate and
identify the appropriate design files.

NOW GOTO THE COMM PORT AND SET THE RIGHT COMM PORT THAT THE
PC DATA CABLE TO PANEL IS CONNECTED TO. (COMM 1 Or COMM 2)

THEN CHOOSE DOWNLOAD TO PANEL. MAKE SURE PC CABLE TO PANEL IS
ATTACHED.



USER WILL BE PROMPTED TO ENTER ACCESS CODE.
( default 8812)

Once the panel details have been identified, the program requests the current panel access
code to be entered. The program then asks whether or not the panel name or job name is
to be used for the company logo on the panel, before checking what information is
available for downloading.

-V GLT Premier AL Panel Download Utility R X

Upload it
Job Number Job Mame [ Diectory |
Pancl Number Pancl Name]

Logo

[rype] ] [Fumber [ [ Hame |

Checking Data Files

Company Logo Options

€ | Do youwant o use the Panel Name o the Job Name for the panels's Company Logo?
L3 Click on 'Ves' For the Panel Name, or dick on Mo’ For the Job Name,

Nate:- For a netwark panel you should select o' since the Panel Mame will be shown separately on the panel, but
either is valid for & stand-alone panel.

The program then tries to identify the panel connected to the serial port
of the computer. A red Progress Bar indicates communication.



. % GLT Premier AL Panel Download Ukility
Upload  Quit

[ Directowy |
Panel Number
[Number [ ] [Name |

Trying to Access Panel

The User will be prompted to ENABLE the SSD DIP SWITCH(WRITE
ENABLE/DISABLE), in the PREMIER AL.



. % GLT Premier AL Panel Download Ukility
Upload  Quit

ob Details [ joh Number [ 11111 | [ Job Name madagascar Directory [\NETWORK_PREM_A

| Panel Humber | h | |Panel Name| SWAMSEA | | Panel Type | 11 |

’I-:'anel Identification [Logo [ ‘“madagascar  ° |

~sion | 84579003 |

Write Protected Prompt

The Site-Specific Data Memory in the
panel is write-protected. Either move
10801000210 the Write-Protect Switch to the
s ‘Enabled' position to proceed with the
ﬁ download. or press the 'Escape’
button on the panel to abort the
process.

pwnload All Files

P load Selected Files

**FFFWARNING, DO NOT DISRUPT OR INTERUPT DOWNLOAD PROCEDURE
OR WHEN PREMEIR AL DISPLAYS “ COMPUTER ACCESS IN PROGRESS PANEL
DISABLED?”, **#****xx

If Interrupted, repeat whole procedure again as data corruption can occur.

The program will default to using the *"COMZ1:" port unless another port is specified in the
GLTCOMM.INI file. This file may be updated via the menu item in the main menu
screen.

Failure to access the panel will terminate the program. If the panel can be accessed, then
its identification details will be extracted and checked as described in 3.5.2. below.

3.5.1. Job & Panel Selection

This facility involves the standard Windows style drive and directory selection boxes, plus
a list of possible jobs, and a list of possible panels. Each time a new directory is selected
the program will check for any design files in that directory, and if it finds any will
display a list of the jobs contained in that directory. It will then automatically

select the first job (which will normally be the only job in a given directory), and display a
list of the panels for that job. If there happens to be more than one job in the same
directory, then clicking on the job list will change the selected job and bring up a list of
panels for the new job.

Selecting a panel, then Clicking on the 'Download’ menu function will continue to the next
stage for the selected panel. Clicking on "Quit" will terminate the program.

3.5.2. Checking Panel Identification.

The identification details retrieved from the panel include the panel’s type code, its
currently defined number and name, and the version of motherboard software installed.



If the type code returned is not 11 which represents the Premier AL panel, then the
program will terminate.

If the panel number returned is different from that specified on the computer, then a
prompt will appear asking whether it is required to change the panel's number or not. If
'No’ is selected, and the number returned by the panel is not 0 then the program will
terminate, otherwise if the number from the panel is 0 then the panel name will be
checked, but if "Yes' is selected then the panel number specified on the computer will

be transferred to the panel, and the program will then proceed to check the panel name.
Similarly if the panel name returned is different from that specified on the computer, then
an option will be given to update the name stored in the panel to that specified on the
computer. This time however selecting "No* will not terminate the program, but proceed
directly to the next stage.

n.b. a stand-alone panel will always return a panel number of 0, and this

cannot be changed.

3.5.3. Selecting Download Information.

When the panel's identification has been successfully checked, a list of suitable data files
existing on the computer will be displayed, with the option to download all of the data, or
just selected files. Clicking on "All" will download all of the available information to the
panel, while Clicking on *Selected" will only download any files that are highlighted

in the list.

n.b. A progress bar will be displayed during each download process for reference. Also if
the panel has a switch for write-protecting its EEPROM memory, and that switch is in the
'Protected’ position, then a warning prompt will be displayed giving the user an
opportunity to move the switch into the 'Enabled" position before proceeding with the
download, or to terminate the download process.

<% GLT Premier AL Panel Download Utility |
Upload  Quit k
Job Details [ Job Number [ T1171 | | Job Name | madagascar | | Directory |\NETWORK_PREM_A
| Panel Humber | L | |Panel Name| SWANSEA | | Panel Type | 11 |
Panel |dentification ’W"J—'|
”TType| 11 | | Mumber | L | | Hame | ‘SWAMNSEA INDUSTRIAL * | | Yersion | 84579003 |

Download Options

8 Click on 'All' to download
il all available data to the
Network Responses ] . panel. or select the
Panel Delay. Day/Hight Parameters. and Software Timer Periods B .
Panel Layout required items from the
Panel Hame to Company Logo list and then click on

Panel Hame to Panel Name . .
Platform Sounders [all loops) Selected' to transfer the

Sensitivity Codes [all loops]
Zone/Group Allocation data.

Download All Files

Download Selected Files




3.5.4. Uploading Information.

When the panel's identification has been successfully checked, a list of
suitable data files existing on the computer will be displayed, with the
option to download all of the data, or just selected files. The menu bar
will also include an Upload option allowing the following items to be
uploaded:-

1. Access Code. If linking to a new panel , and user wants to change access code.

2. Panel Layout. User can check panels layout, and analyse/diagnose any /settings.
3. Delay Parameters. User ¢ check panels delay settings

4. Point Texts (Individual loops or all loops). User can analyse/modify device labels.
5. Input Texts. 1/0 board names/labels.

6. Point Sensitivity (Individual loops, all loops, or manual). User can analyse/diagnose the
sensor / point levels for alert and alarm. i.e 45 alert and 70 alarm

7. Analogue Values (Individual loops or all loops).**SEE DIAGRAM BELOW**

8. Zone/Group Allocation. User can uploads current zone group configuration.

9. Local Cause/Effect. User can analyse/diagnose, cause and effect setttings

10. Network Cause/Effect.

11. Network Responses.

** Once all or Any of the above information IN Uploaded, it can then be printed via the
print menu******

<3 GLT Premier AL Panel Download Ukility

Upload  Quit

Aocess Code

Directory [}
Panel Layout: = =

Delay Parameters | | m
Paink Texts —

Input Texts L

Poink Sensitivity g || B [ Version

Analogue Yalues

Zone/Group Allacation Download Options:

2 AT
Local CausefEFfect Loop 2 §Click Of_'l All' to download
Metwork Cause/Effect Loop 3 all available data to the
Metwork Responses Loop 4 panel, or select the
Loop 2 Point Tests required items from the
Loop 3 Point Texts list and then click on
Metwork Responses v :

Panel Delay, Day/Might Parameters, and Software Timer Periods Selected' to transfer the
Panel Layout data

Panel Name to Panel Hame 2

Platform Sounders [all loops)

Sensitivity Codes [all loopsz) Download All Files
Zone/Group Allocation

Download Selected Files




Appendix A - Cable Connections for Download
Panel (DB9F) Computer (DB9F) Computer (DB25F)

2 3 2

3 2 3

5 5 7

This is equivalent to a standard "NULL-MODEM" type cable that is readily
available from many computer stores.

S PIN D-TYPE
CCNINECTOR

FEMALE R3 Z32
SERIAL CONNECTOR

S PIN D-TYPE
CONNECTOR

FEMALE R3 232
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CABLE SHOULD BE 3 CORE AND SCREENED. CABLE LENGTH
SHOULD BE AT LEAST A COUPLE OF METRES, OR USER {
CUSTOMER CHOICE

TIPS:

BACKUP FOLDERS . ALWAYS BACK UP CAUSE AND EFFECT FOLDERS. SO
THAT ANY ERRORS OR FILE CORRUPTION CAN SIMPLY BE RECTIFIED < BY
EDITING OR REPLACING WITH A RECENT BACK UP. BACK UP PROCEDURE IS
BY SIMPLY COPY/PASTE FOLDER IN WINDOWS. THIS IS ALSO
RECOMMENEDED FOR WHEN CREATING CAUSE AND EFFECT CHANGES.
FIRST BACK UP FOLDER AND THEN CREATE CAUSE AND EFFECT CHANGE.

IF AFAULT OR ZONAL LIGHT DOES NOT DISSAPPEAR FROM THE FRONT
PANEL, AND USER HAS DELETED A BADLY WRITTEN CAUSE AND EFFECT.
THEN DOWNLOAD A NEW CLEAN/NON PROGRAMMED FILE AND THEN
DOWNLOAD THE ORINGINAL CAUSE AND EFFECT FILE.

If Encountering, runtime errors, or programs accesss problems. Press
CTRL+ALT+DELETE , and make sure to shut down GLT processes in Background,
Then Quit all GLT Cause Effect software, and re open programs again.



